Dynamic clamp with StdpC software
Article (Accepted Version)

Kemenes, Ildikó, Marra, Vincenzo, Crossley, Michael, Samu, Dávid, Staras, Kevin, Kemenes,
György and Nowotny, Thomas (2011) Dynamic clamp with StdpC software. Nature Protocols, 6
(3). pp. 405-417. ISSN 1754-2189
This version is available from Sussex Research Online: http://sro.sussex.ac.uk/id/eprint/17184/
This document is made available in accordance with publisher policies and may differ from the
published version or from the version of record. If you wish to cite this item you are advised to
consult the publisher’s version. Please see the URL above for details on accessing the published
version.

Copyright and reuse:
Sussex Research Online is a digital repository of the research output of the University.
Copyright and all moral rights to the version of the paper presented here belong to the individual
author(s) and/or other copyright owners. To the extent reasonable and practicable, the material
made available in SRO has been checked for eligibility before being made available.
Copies of full text items generally can be reproduced, displayed or performed and given to third
parties in any format or medium for personal research or study, educational, or not-for-profit
purposes without prior permission or charge, provided that the authors, title and full bibliographic
details are credited, a hyperlink and/or URL is given for the original metadata page and the
content is not changed in any way.

http://sro.sussex.ac.uk

Europe PMC Funders Group
Author Manuscript
Nat Protoc. Author manuscript; available in PMC 2011 October 06.
Published in final edited form as:
Nat Protoc. 2011 March ; 6(3): 405–417. doi:10.1038/nprot.2010.200.

Europe PMC Funders Author Manuscripts

Dynamic clamp with StdpC software
Ildikó Kemenes*,
School of Life Sciences, University of Sussex, Brighton, UK, I.Kemenes@sussex.ac.uk
Vincenzo Marra*,
School of Life Sciences, University of Sussex, Brighton, UK, V.Marra@sussex.ac.uk
Michael Crossley,
School of Life Sciences, University of Sussex, Brighton, UK, M.Crossley@sussex.ac.uk
Dávid Samu,
School of Informatics, University of Sussex, Brighton, UK, D.Samu@sussex.ac.uk
Kevin Staras,
School of Life Sciences, University of Sussex, Brighton, UK, K.Staras@sussex.ac.uk
György Kemenes, and
School of Life Sciences, University of Sussex, Brighton, UK, G.Kemenes@sussex.ac.uk
Thomas Nowotny
School of Informatics, University of Sussex, Brighton, UK, t.nowotny@sussex.ac.uk, web: http://
www.sussex.ac.uk/informatics/tnowotny, corresponding author, telephone +44-1273-601652, fax
+44-1273-877873

Abstract
Europe PMC Funders Author Manuscripts

Dynamic clamp is a powerful method that allows the introduction of artificial electrical
components into target cells to simulate ionic conductances and synaptic inputs. This method is
based on a fast cycle of measuring the membrane potential of a cell, calculating the current of a
desired simulated component using an appropriate model and injecting this current into the cell.
Here, we present a dynamic clamp protocol using free, fully integrated, open-source software
(StdpC, Spike timing dependent plasticity Clamp). Use of this protocol does not require specialist
hardware, costly commercial software, experience in real time operating systems or a strong
programming background. The software enables the configuration and operation of a wide range
of complex and fully automated dynamic clamp experiments via an intuitive and powerful
interface with a minimal initial lead-time of a few hours. After initial configuration, experimental
results can be generated within minutes of cell impalement.
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Introduction
The dynamic clamp method was introduced independently by Robinson and Kawai1 and
Sharp et al.2 Initially it was used to introduce artificial conductances into neurons to mimic
the effect of voltage-gated ion channels and synaptic inputs arising from other neurons3,4.
More recently, with further developments in hardware and software, it has become an
important tool for a broad range of applications, including the full control of cell activity
(pattern clamp)5, the simulation of forms of synaptic plasticity6,7,8, the connection of living
neurons to simulated9 and electronic10 neuron models and neuron model populations11,12
and even the connection of preparations from different animals through simulated
synapses13. In addition to a range of central neurons, dynamic clamp has also been used to
study sensory cells14,15, motoneurons16, endocrine cells17,18, cardiac cells19,20,21 and the
peripheral nervous system22,23. Other researchers have even extended the principles of
dynamic clamp to interact with the nervous system through mechanical stimulation24 or
micro-injection of drugs25.
All dynamic clamp methods are based on the same general principle. Central to this is a fast
“dynamic clamp cycle”, comprised of three main components. First, the membrane potential
of a cell is measured, then a computer calculates the current that would flow through a
simulated electrical component of the cell at the measured potential, and finally, this current
is then injected into the cell. If the cycle is executed fast enough (typical implementations
exceed 10 kHz), the membrane potential of the cell will be indistinguishable from a situation
in which the simulated electrical component is actually present in the membrane. See Fig. 1
for an illustration of this general dynamic clamp principle.
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Since the introduction of the principal method a number of different implementations have
been developed, each with particular advantages and disadvantages. While some approaches
invested considerable effort on precisely fulfilling real-time constraints (i.e., fixed length
time step intervals in the dynamic clamp cycle) such as real-time Linux-based, digital signal
processing-based, and early analog solutions, others emphasized the importance of ease of
installation and use. Some of the most common dynamic clamp implementations are listed
in Table 1 (see26-29 for more detailed reviews of dynamic clamp and its implementations).
Although many studies have used dynamic clamp methods (for examples, see26-30), they
have never quite become a standard tool in electrophysiology in spite of their huge potential
for actively probing neuronal systems. We can identify at least two reasons for this: 1) most
implementations require a high initial investment into specialized hardware and software
and/or a lot of technological expertise that is not available in a typical electrophysiology
group. 2) the design of dynamic clamp experiments is different from standard
electrophysiology and is not typically part of standard electrophysiology training.
The protocol based on StdpC, presented here, addresses these problems in the following
ways: 1) StdpC can be downloaded for free at http://sourceforge.net/projects/stdpc/ and is
released under the GNU General Public Licence (GPL). It runs on standard Windows
platforms and requires only a data acquisition board in addition to a standard
electrophysiology setup. It supports the traditional Digidata 1200/1200A boards (Axon
Instruments, part of Danaher, Washington DC) as well as any NIDAQ-enabled National
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Instruments board (National Instruments, Austin, Texas), devices that are commonly already
present in most electrophysiology laboratories. 2) The system requires minimal expertise for
setting up dynamic clamp experiments and can be used by any electrophysiologist without
extended additional training.

StdpC
Europe PMC Funders Author Manuscripts

StdpC7 is based on software originally developed by Pinto et al.31. In its current form, the
software has a modern graphical interface based on QT (Nokia) and is suitable for general
public use. It permits the definition of up to six voltage-gated conductances and/or up to six
synapses using built-in standard models for gap junctions and chemical synapses as well as
two standard formalisms for Hodgkin-Huxley type voltage-dependent ionic conductances.
The synapses can additionally be specified to be plastic according to two common
formalisms (additive spike-timing dependent plasticity (STDP) rule32, or ordinary
differential equations (ODE) based STDP formalism33). Additionally, a configurable
artificial neuron can be connected to the preparation through StdpC’s versatile spike
generator facility.
Besides the fully integrated graphical user interface, the software also includes a basic but
powerful scripting mechanism for automatically adjusting all aspects of an introduced
dynamic clamp object (e.g., maximal conductance or time constants of synapses and ion
channels) during the experiment according to pre-defined experimental protocols. This
allows complex experimental designs that can be run semi-automatically on many
preparations.
Practical considerations and limitations
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When considering the use of a dynamic clamp protocol it is important to be aware of the
limitations of the approach. One principal limitation is that dynamic clamp only simulates
the effect of an electrical component in the cell membrane, not the actual flow of specific
ions. Thus, the effects of an ion acting as a second messenger (e.g., Ca2+ activating calciumcalmodulin dependent kinase enzymes), cannot be simulated by dynamic clamp. Similarly,
so far it has not been possible to simulate ligand-gated ion channels using dynamic clamp.
With modern computers and interface boards, hardware limitations are unlikely to be a
major concern for the most typical dynamic clamp applications. StdpC allows the
simultaneous use of up to six ion channels and six synapses. We have found that using
biologically realistic time scales, the variable soft real-time dynamic clamp cycle with a
typical >20 kHz mean cycle frequency7 does not present a major limitation. Finally, the
setup we outline here involves two separate computers, one for dynamic clamp and another
for recording. In theory, there are no key reasons why a single computer cannot be used to
perform both tasks although this has not been exhaustively tested with StdpC.

Experimental Design
The common design principle of dynamic clamp experimentation is the so called dynamic
clamp cycle. The membrane potential of one or several neurons is measured and model
equations, which depend on the measured membrane potential(s), are evaluated on the
dynamic clamp computer resulting in (a) current amplitude value(s). The corresponding
current(s) is (are) then injected into the target cell(s).
In the procedures detailed below we outline three typical dynamic clamp experiments: 1. the
simulation of a chemical synapse, 2. the introduction of an ionic current and 3. a pattern
clamp experiment.
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1.

When introducing an artificial synapse, the current entering the post-synaptic cell
depends on the membrane potential of the pre-synaptic neuron by virtue of the
voltage-dependent transmitter release and on the membrane potential of the postsynaptic target cell through Ohm’s law. Accordingly, in this experiment, two
neurons are monitored intracellularly and one of them, the designated post-synaptic
cell of the simulated synapse receives current injections. The current through the
simulated synapse is calculated from the measured pre- and post-synaptic
membrane potentials using a computational model. StdpC provides two common
computational models for chemical synapses; the one used for our example dataset
(see below) is illustrated in Box 1.

2.

When introducing a simulated ion channel into a target neuron, only the target
neuron’s membrane potential needs to be measured and current injections occur
into the same cell. The computational model in this case is based on HodgkinHuxley-type equations. StdpC provides two common formalisms to parameterise
the equations. The formalism used in the anticipated results (below) is illustrated in
the supplementary equations.

3.

In pattern clamp, both a simulated neuron and a simulated strong gap junction are
used. A target cell is monitored and its membrane potential is clamped to the
activity pattern of the membrane potential of the simulated neuron by the simulated
gap junction.

In the anticipated results section we show examples of these three types of experiments
using either neurons from a classical molluscan preparation or neurons from dissociated
hippocampal cultures.
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For designing new dynamic clamp experiments, or adapting existing ones, the experimenter
needs to identify which measurements need to be taken, which neurons need to receive
current injections and what the magnitudes of the measured signals and injected currents are.
When using a single recording/injecting electrode, it is important to reduce any artefact in
the readout of the voltage that may be caused by the simultaneous current injections (see
step 4 in the procedure for a list of options). The voltage drop across an uncompensated
electrode is proportional to the electrode resistance and the amplitude of the injected current
and becomes problematic in procedures that require large current injections such as pattern
clamp. The voltage artefact is absent when no current is injected; for this reason no
compensation is required when using two different electrodes for voltage recording and
current injection. On the other hand, injection artefacts can typically be ignored when the
resistance of the electrode is low (e.g., in patch clamp) and the current injection amplitudes
are small.
Other parameters that need to be taken into account when designing experiments are the
maximum number of electrodes and manipulators that can be used at once on a preparation
and the number of input and output channels available on the data acquisition board used for
dynamic clamp. For example, the Digidata 1200/A boards have two analog outputs whereas
the NI PCI-6229 card we used here has four. The number of analog inputs is typically less
problematic. The Digidata 1200/A has 16 while the NI PCI-6229 board has 32. Along with
the practical experimental considerations, another important consideration in designing
dynamic clamp experiments is to formulate or obtain an accurate computational model of
the simulated electrical component. For example, for simulating ion channels, a HodgkinHuxley type model with accurate parameter values is required or, for simulating a synapse, a
full description including conductance, time scale, activation characteristics and reversal
potential is necessary.
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Unlike in other experimental paradigms there is typically no need for elaborate negative
controls in dynamic clamp other than measuring the activity with and without the simulated
component repeatedly and preferably in several preparations. It is good practice, however, to
inspect the data offline and re-calculate on a computer that the current injection, as measured
on the independent electrophysiology workstation (see Figure 1), was correct according to
the computational model used.
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EQUIPMENT
Standard electrophysiology rig
The rig needs to be capable of intracellular recordings in current clamp mode and current
injection into neurons. Typically, the necessary equipment would be:
-

Microelectrodes

-

Headstages and a microelectrode amplifier. StdpC does not impose any
restriction on the amplifier used; even a combination of different types of
amplifiers is possible. In the results presented below we have used an Axoclamp
2 amplifier (Axon Instruments, part of Danaher, Washington, DC)

-

Appropriate cables to connect the amplifier with the data acquisition board
(usually standard BNC cables)

-

A computer with electrophysiology software. Below we have used a Pentium 4,
2.8 GHz PC with 1 GB of RAM, Windows 2000 operating system and Spike2
software (CED, Cambridge).

Data acquisition board
We recommend the following data acquisition boards:

Europe PMC Funders Author Manuscripts

-

Digidata 1200/1200A (Axon Instruments, part of Danaher, Washington, DC).
Note that modern Axon Instruments boards could not be supported because the
technical specifications of their interfaces have not been disclosed. With a recent
merger this situation has now changed and we may be able to develop hardware
drivers for these boards in the future.

-

Any National Instrument board (National Instruments, Austin, Texas) that
supports the NIDAQ device interface and has at least two analog inputs and two
analog outputs (e.g. the National Instruments (NI) “E” or “M” series boards).
For the results below we have used the NI M-series PCI-6229 board with 4
analog outputs (833 kS/s) and 32 analog inputs (250 kS/s). It is recommended
that you choose a board with >100 kS/s sampling frequencies.

OR

Dynamic clamp PC
Any recent PC with Windows 2000, Windows XP (both Digidata and NI boards) or
Windows 7 (NI boards only). StdpC has been tested and confirmed to work for these
operating systems, although we have only trialled Windows 7 Professional 64 bit. As StdpC
runs in the 32 bit compatibility mode in Windows 7 ×64, we anticipate that Windows Vista
and other versions of Windows 7 will work with NI boards as well. The old Digidata 1200/A
boards are not recognised in Windows 7 according to our tests. The Digidata board requires
an ISA bus slot, commonly not available in modern PCs. If a lab does not have a previously
installed Digidata 1200/A setup, it is recommended to use the National Instruments option.
Alternatively, specialist industrial PCs with legacy ISA bus support are available, e.g. from
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Spectra Computer Systeme GmbH, Leinfelden, Germany. For the results presented below,
we have used a 1.8 GHz Intel Core 2 CPU 6320 based PC with 1GB RAM and Windows
XP.
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For advanced users, who wish to modify the source code of the original StdpC software in
order to alter or extend parts of it to their specific needs, another requirement is to have the
QT software framework and development environment installed for compiling the software
from its source code (QT is available under the GNU public license at http://qt.nokia.com/
products free of charge).

EQUIPMENT SETUP
Standard electrophysiology rig
Typically, dynamic clamp is used with either two or more sharp electrodes or one or more
low resistance patch electrodes. Each electrode should be connected via the electrode
headstage to the appropriate electrode socket of the amplifier, and the amplifier voltage
output (typically labeled V1, V2) should be connected to the data acquisition board used for
recording. The data acquisition board should be connected to a recording computer with
electrophysiology software installed (e.g. Clampex, WinEDR, WinWCP, Spike2). This is a
standard setup for any electrophysiological experiment. Special care should be taken to
choose the amplifier’s output channels to obtain the highest possible signal-to-noise ratio;
the highest amplification which does not exceed the input range of the data acquisition board
for expected signal amplitudes is usually best. It is recommended to filter the membrane
potential with hardware filters because, unlike in a normal electrophysiological recording,
noise in the membrane potential recording feeds back into the system through the dynamic
clamp.

PROCEDURE
StdpC and hardware installation
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TIMING 2-3 h—1 Download StdpC. Direct your browser to http://sourceforge.net/projects/
stdpc/ and click the “Download now!” button. Choose “save” in the dialog box that appears
and save the file StdpC2010.zip in a convenient location (e.g. your desktop). Unzip the file.
It will create its own sub-directory StdpC2010-bin. This completes the software installation.
TROUBLESHOOTING
PAUSE POINT: The installation is only required once and does not need to be repeated in
subsequent uses of the protocol.
2 Install the data acquisition board in the dynamic clamp computer according to the
manufacturer’s instructions. In the case of NI devices, install the manufacturer-provided
windows drivers. Calibrate the board with the manufacturer’s tools.
PAUSE POINT: The device installation is only necessary once.
3 Connect the dynamic clamp acquisition board to the amplifier. For a two-electrode
configuration, you will be using two electrodes in every cell that receives input from the
dynamic clamp. One is the “recording electrode”. Connect the voltage output of this
electrode on the amplifier to an input channel of the dynamic clamp acquisition board. The
other electrode is the “injection electrode”. Care should be taken to choose the correct gain
for current injection. Connect an analog output channel of the dynamic clamp acquisition
board to the current command input for this electrode on the amplifier. Other cells can be
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used as pre-synaptic cells for simulated synapses. For these cells use and connect only one
“recording electrode”. The separate electrodes for injection and recording serve the purpose
of avoiding current injection artifacts in the recorded membrane potential. Alternatively,
single low resistance electrodes, with artifact compensation (e.g. bridge balance,
discontinuous current injection, or the recently introduced active electrode compensation
(AEC)34,35. The most recent version of StdpC includes an AEC feature.) can be used for
both recording and current injection.
4 Adjust the amplifier settings. Perform all experiments with StdpC in current clamp mode.
StdpC configuration
TIMING 1 h—5 Start StdpC. There are two alternative options for this step depending on
whether you are using a National Instruments board or a Digidata 1200/1200A board.
A If you are using a National Instruments board, double-click StdpC2010-Nidaq.exe.
B If you are using a Digidata board, double-click StdpC2010-Basic.exe.
If you have both boards installed you should use option A.
TROUBLESHOOTING—6 Choose your dynamic clamp acquisition board from the
dropdown menu on the top of the main window of StdpC. The message window will show a
message “Good news: <board name> found and opened successfully”.
TROUBLESHOOTING—7 Set up the input channel configuration in StdpC.
Click “Config->Input Channels” (marker 1 in Fig. 2) and choose a data acquisition range for
each channel that you are using (the channels you connected the amplifier to in step 3).
Choose the smallest range that includes your expected signal amplitudes for best results.
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Enter the overall amplifier gain for each input channel. This is the product of the headstage
gain, the amplifier gain and the gain of any other pre-amplifiers or filters. The gain is
entered as the ratio between the actual voltage at the electrode and the corresponding voltage
present at the dynamic clamp acquisition board. For example, if there is 10x amplification in
the amplifier and no other amplification, the conversion factor would be 1/10= 0.1.
Choose to save a channel on disk by clicking on the “Save Channel” checkbox.
CRITICAL STEP—All input channels are denoted in a “StdpC-centric” way, i.e. the input
channels are the recorded membrane potential of neurons (output of the neurons but inputs
to the dynamic clamp) and the output channels are the current commands for the injection of
currents into neurons (input to the neurons but outputs from the dynamic clamp).
CRITICAL STEP—Setting the most appropriate acquisition ranges and correct gain factors
is an essential step when using StdpC. An acquisition range that is too small will lead to
clipped signals and associated errors in the injected current. If the acquisition range is too
large, this will lead to unnecessary digitization noise and degrade the quality of the dynamic
clamp. If the conversion factor is incorrect, all inputs can appear to be 0 or always saturated,
similar to what you might observe during a hardware failure.
TROUBLESHOOTING—8 Set up the output channel configuration in StdpC.
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Click “Config->Output Channels” and choose output ranges and conversion factors as for
the input channels in the previous step. Here, the conversion factor is entered as the ratio
between the command voltage that is generated at the dynamic clamp acquisition board (in
V) and the resulting current injected at the electrode (in nA). For example, if the current
command of the amplifier generates 10 nA / V the conversion factor is 0.1. Choose whether
to save a channel on disk with the “Save Channel” checkbox.
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CRITICAL STEP—As with the input channels, all output channels are denoted in a
“StdpC-centric” way.
CRITICAL STEP—Setting the most appropriate output ranges and correct conversion
factors is an essential step when using StdpC. Too small output range will lead to clipped
signals and associated errors in the injected current. An output range that is too large will
lead to unnecessary digitization noise and degrade the quality of the dynamic clamp.
Incorrect conversion factors will lead to inappropriate current commands that may even
damage the biological preparation.
TROUBLESHOOTING—9 Test the input and output channel settings.
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The best way to test the correctness of acquisition/ output range and conversion factor
settings is to directly test each input and output channels that is used. To test an input
channel, activate one of StdpC’s graphical display windows (marker 8 in Fig. 2) by clicking
the “Settings” button next to it and select a channel to test from the dropdown menu in the
dialog window that appears. Choose a minimum and maximum limit for the y axis of the
display and the unit (mV for input channels and nA for output channels). Hit the Start button
of the main window (marker 2 in Fig. 2) and check, whether the displayed voltage is correct.
You can manipulate the voltage on the amplifier (amplifier offset) to establish this. When
this is satisfactory, hit the Stop button (marker 3 in Fig. 2) and disable the display by
choosing “None” in the Data dropdown box of the Data display dialog. The graphical
displays compete with the core dynamic clamp software for CPU and memory resources
and, if left active, can degrade the quality of dynamic clamp. We, therefore, recommend
using the data displays for testing only.
In order to test an output channel, open the Config->Output Channels dialog box and enter a
“Bias current” for the channel. Click the Start button and check on your amplifier display,
your recording computer or an external oscilloscope that the voltage generated on the
dynamic clamp data acquisition board matches the voltage command that is necessary to
generate the chosen bias current. When this is satisfactory, stop the dynamic clamp with the
Stop button and reset the bias current to 0.
Defining the simulated electrical component(s)
TIMING 10-30 min—10 Depending on the scientific enquiry there are many options for
this step. Here, we describe three classical examples: a simulated synapse, a simulated
Hodgkin-Huxley type ionic conductance, and a pattern clamp experiment.
A Simulated chemical synapse.
i.

Click on one of the Synapse drop-down boxes (marker 5 in Fig. 2) and choose
“Chemical”.

ii. Click the “Parameters” button below.
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iii. In the dialog box that appears choose the Presynaptic Channel, i.e. the number of
the analog input channel of the dynamic clamp acquisition board to which the
recording electrode of the pre-synaptic cell is connected.
iv. Choose the Postsynaptic Channel, i.e. the number of the analog input channel of the
dynamic clamp acquisition board to which the recording electrode of the postsynaptic cell is connected.
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v.

Choose the Output Channel, i.e. the number of the analog output channel of the
dynamic clamp acquisition board which is connected to the current command
socket of the current injection electrode in the post-synaptic cell.

vi. Enter parameters of the simulated synapse. The main parameters (“Standard”) are
explained in Box 1. All possible advanced options and parameters are explained in
the StdpC manual that is distributed with the StdpC software.
B Simulated Hodgkin-Huxley conductance.
i.

Choose the formalism of your model for the conductance from one of the Ionic
conductance dropdown boxes (marker 6 in Fig. 2). This activates the ionic
conductance model.

ii. Click the “Parameters” button below.
iii. In the dialog box that appears, choose “V inChannel” as the analog input channel of
the dynamic clamp data acquisition board that is connected to the recording
electrode in the target cell.
iv. Choose “I outChannel” as the analog output channel of the dynamic clamp data
acquisition board that is connected to the current command input of the amplifier
for the current injection electrode.
v.

Enter the maximal conductance of the channel and the reversal potential.
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vi. Enter the parameters of your model for activation and inactivation. A detailed
explanation of the supported Hodgkin-Huxley formalisms and the corresponding
parameters is given in the StdpC manual. The equations for the α-β formalism used
for the anticipated results below are given in the supplementary equations.
C Pattern clamp.
i.

In the “Spike generator” sub-panel (marker 7 in Fig. 2), choose “Explicit Spike
times” from the Spike Method dropdown box.

ii. Enter desired properties of the pre-synaptic spikes: Vspike = desired spike
amplitude; Width = desired spike duration, VRest = desired resting potential.
iii. Enter the number of spikes per burst and a bursting period.
iv. Click the “Spike Times” button and enter the relative spike times of spikes within
each burst with respect to the start of the burst. The default settings produce a
somewhat irregular burst with 10 spikes and spike deceleration in the second half
of the burst. Other options for specifying presynaptic spiking are explained in the
StdpC manual.
v.

Choose “Gap Junction” in one of the Synapses drop-down boxes (marker 5 in Fig.
2).

vi. Click the “Parameters” button below it.
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vii. In the dialog box that appears choose the spike generator “SG” for the Presynaptic
input Channel.
viii. Choose the channel number of the dynamic clamp acquisition board’s input
channel connected to the controlled cell’s recording electrode as the Postsynaptic
input Channel.
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ix. Choose “None” for the presynaptic output channel.
x.

Choose the channel number of the output channel connected to the current
command of the controlled cell’s current injection electrode as the Postsynaptic
output Channel.

xi. Enter a high conductance on the order of 50 nS for the parameter gSyn.
CRITICAL STEP—It is important to find the right synaptic conductance gSyn by
experimentation. If it is too low, the target cell will not be well controlled, if it is too high,
there will be strong ringing noise. Compare the anticipated results in Fig. 3 below that show
examples of successful and unsuccessful pattern clamp (Fig. 3 C-E).
TROUBLE SHOOTING
PAUSE POINT—Once the hardware and software configurations are complete, the whole
configuration can be saved by clicking “File->Save Protocol” and choosing a file location
and name. In subsequent experiments, steps 7-10 can be replaced by step 11.
CRITICAL STEP—Enter a file name ending on “.cpr” (“clamp protocol”) for the saved
configuration to retrieve it easily in the future.
11 Load a previously saved configuration.
Click “File->Load Protocol”, navigate to the previously saved protocol file, select it by
mouse click and then click “Open”.
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TROUBLESHOOTING
Experimental preparation
TIMING 30 min – 4 h—12 Set up the biological preparation.
The details of this experiment-specific step are independent of the general protocol
described here. StdpC can be used for dynamic clamp in electrophysiological experiments
based on both intracellular and whole-cell patch-recordings.
Dynamic clamp
TIMING 40 min - 12 h—13 Prepare electrodes.
The characteristics of the electrodes used for dynamic clamp depends mostly on the
preparation in use. In general, low impedance electrodes are advised for injection of large
currents. Insert the electrodes into the head stages and immerse them into the bathing
solution appropriate for the preparation under study.
14 Assess properties of the electrodes in solution.
When your electrodes are in the saline, measure their characteristics, paying particular
attention to the resistance. If the observed resistance is much higher than expected for the
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type of electrode you are using, the success of the dynamic clamp experiment may be
compromised.
If you have not already done so, set your amplifier in current clamp mode and adjust the
amplifier offset on each channel so that the measured potential is 0.

Europe PMC Funders Author Manuscripts

15 Insert electrodes into target cells or perform whole-cell patch clamp recording. There are
different configurations for this depending on whether you are simulating a chemical
synapse, introduce a simulated Hodgkin-Huxley conductance, or performing pattern clamp:
A Chemical synapse simulation:
Obtain voltage recordings from the designated pre- and post-synaptic cells. Current
will need to be injected into the post-synaptic cell, either using a second electrode,
or the voltage recording electrode with appropriate compensations, as outlined in
point 4.
B Simulated Hodgkin-Huxley conductance:
Obtain voltage recording from the target cell. Current will be injected into the same
target cell, either using a second electrode, or the voltage recording electrode with
appropriate compensations, as outlined in point 4.
C Pattern clamp:
Obtain voltage recording from the target cell. The same electrode used to record
voltage can be used to inject current, but due to the large amount of current that is
typically necessary to impose a pattern onto a cell, the use of a second “injecting”
electrode is preferred in this configuration.
Insert recording and injection electrode into the neuron that was chosen to be
controlled.
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16 Assess the properties of each electrode in the cell. Pay particular attention to the stability
of the recording, that the recorded signal reasonably reflects the actual (anticipated)
membrane potential and that the cell has reasonable membrane resistance. These
characteristics vary depending on the cell type. In the preparations used below one observes
typical resistances of 15-45 MΩ in the CGC cell and 5-10 MΩ in the hippocampal cells.
17 Start recording on the separate recording computer and click the “Start” button (marker 2
in Fig. 2) in StdpC. This starts the dynamic clamp cycle and the simulated electrical
component is added to the target cell until the “Stop” button (marker 3 in Fig.2) is pressed.
Parameters in StdpC can be manipulated while the dynamic clamp is running but changes
will only take effect at the next time when “Start” is pressed.
TROUBLESHOOTING
Data Processing
TIMING 1 h – 1 day—18 Process experimental data off line. During the experiment, all
the relevant data (time, membrane potential, injected currents) are being saved according to
the data saving configuration set in steps 7 and 8. Independently, all signals are recorded and
saved on the recording workstation. Post-processing involves the analysis and visualization
of the data using any statistical platform of the user’s preference (Origin, Matlab, Octave,
Scilab, R, Python (Pylab/SciPy), etc).
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TIMING
Steps 1- 4, StdpC and hardware installation: 2-3 h
Steps 5-9, StdpC Configuration: 1h
Step 10, Defining the simulated electrical component(s): 10-30 min

Europe PMC Funders Author Manuscripts

Steps 12, Experimental preparation: Depends strongly on the preparation, 30 min – 4 h
Step 13-17, Dynamic clamp: Depends on the experimental design and longevity of the
preparation, 40 min – 12 h.
Step 18, Data analysis: Depends on the scientific problem, 1 h – 1 day

TROUBLESHOOTING
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Step

Problem

Possible reason

Solution

1

unzipping
“StdpC.zip” fails
with
an error message
“zip file empty” or
“zip file broken”

In rare cases the
download can be
interrupted, leading
to a damaged
archive file.

Refresh the StdpC webpage
in your browser and try
downloading again.

5

Starting StdpCNidaq fails with the
error message “The
program can’t start
because nicaiu.dll
is
missing from your
computer … ”

You either do not
have a National
Instruments driver
software installed or
this installation is
broken.

(Re)install National
Instruments driver software
or use StdpC-Basic with a
Digidata board.

6

You see the error
message “Bad
news:
<board name> not
found or not
opened
successfully!” in
the
StdpC mesage
window.

There is a problem
with your data
acquisition board
installation. If you are
using a Digidata
board this may be
due to an I/O
address conflict.
If you are trying to
use a National
Instruments board,
this error can occur
due to a mismatch in
the device name.

The StdpC manual explains
in detail how to solve I/O
address conflicts.
In case of a National
Instruments board, StdpC
expects to use the device
“Devi” by default. If your NI
device has a different name,
open Config->DAQ and enter
the correct device name in
the dialog window that
appears.

7,8

The signal-to-noise
ratio (SNR) on an
input or output
channel is too low.

Excessive noise can
be caused by
sources of electromagnetic radiation in
proximity to the
electrodes, preamplifiers or
amplifier,
inappropriately
chosen channels on
the amplifier(s) or
inappropriate
digitalization ranges
on the input/output
channel
configuration.

Besides eliminating classical
noise sources (line noise, PC
monitor noise, pump noise,
lighting, etc, see e.g. The
Axon Guide45 or other
electro-physiology manuals
for detailed discussions),
there are two key points of
consideration to increase
SNR:
1, Prioritize the electrodes
and assign higher quality
equipment (electrode
headstage, amplifier channel,
any intermediate amplifier,
etc.) to more important
electrodes.
2, Always make sure, that
the most appropriate
digitalization range is used
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Step

Problem

Possible reason

Solution
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on the DAQ I/O channels
both for data acquisition and
current injection. Too wide
ranges (eg. +−10V for
recording or +−30 nA for
injection) increase SNR
unnecessarily, while too low
ranges do not allow
recording and/or injecting the
required signal amplitudes.
StdpC warns the user about
possible signal clipping
whenever the value of any
voltage or current channel
gets close to its upper or
lower limit.
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11

You navigated to a
directory
containing
a saved
configuration but
cannot find it in the
“open protocol”
dialog.

The file is named
incorrectly. Only files
ending on “.cpr” will
appear as possible
choices in the “open
protocol” dialog.

Rename the file in a
Windows file browser.
Alternatively, differently
named files can still be
opened by typing their file
name explicitly.

17

Pattern clamp
appears
unsuccessful (the
target neuron does
not show the
intended spiking
pattern) or a
ringing
noise appears.

The synaptic
conductance of the
simulated gap
junction is too low or
too high.
The target neuron is
too large.

Adjust the gSyn parameter in
the gap junction parameter
dialog. Enter a small (10 nS)
synaptic conductance and
start the dynamic clamp only
for a short time. Observe on
the recording computer
whether the target neuron
follows the “command
waveform” of the spike
generator closely. If not,
increase the synaptic
conductance in increments
(e.g. doubling it) until the
match becomes better. Stop
immediately and downregulate if you observe a
ringing noise. Large cells can
be hard to pattern clamp and
require very large current
injections. If you are in doubt
what the pattern waveform
should look like you can
display it following
instructions in Step 9 and
choosing to display “SG”
(“Spike Generator”).

17

There are no ouputs
from the dynamic
clamp system (flat
line).

There are many
possible reasons, the
most common:
1

Conversion factors
are set wrong.

2

The dynamic clamp
acquisition board is
not installed correctly

3

The connections from
the dynamic clamp
acquisition board to
the amplifier are not
correct

4

The current injection
function on the

1

Repeat and test the configuration of
input and output channels using the
instructions in Steps 7-9

2

Test the acquisition board with the
manufacturer’s tools. Make sure the
message “Good news: <board name>
found …” did appear in the StdpC
message window.

3

Use the recording data acquisition
board or an oscilloscope to monitor
the output from the dynamic clamp
acquisition board’s output channel
that normally connects to the
amplifier. Complementary to this, use
a different command source (e.g. a
signal generator) to try giving current
commands to the amplifier.
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Step

Problem

Possible reason
amplifier is switched
off.
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17

There is an offset
to
the command
voltage/ current
injection.

The characteristics
of the recorded
voltage trace are
(slowly) changing
without any
apparent
reason.

There are two common reasons:
1

A direct current
injection is added by
the amplifier through
settings on the
amplifier.

2

There is a problem
with the calibration
of the output channel
of the dynamic clamp
acquisition board.

There is a problem
with the
electrophysiological
recording.

Solution
4

Toggle the switch for current injection
for the channel of the current injection
electrode.

To decide which problem
applies, visualize the output
of the dynamic clamp
acquisition board channel on
the recording computer or an
oscilloscope. If the offset is
visible, perform a
recalibration of the dynamic
clamp acquisition board with
the manufacturer’s tools.
Otherwise the source of the
offset is the amplifier. Turn
explicit current commands to
0 on the amplifier interface.
Consult the amplifier’s
manual on how to adjust
these settings.
Adjust the electrodes.
Possible steps to be taken
may include adjusting
electrode position, reinserting
electrodes, changing
electrodes, using different
cells or even a fresh
preparation. It may also be
worth checking/ changing the
reference electrode.

ANTICIPATED RESULTS
Simulated chemical synapse

Europe PMC Funders Author Manuscripts

A chemical synapse was simulated between a large (~100 μm diameter) tonically firing
neuron (Cerebral Giant Cell, CGC46), which plays a modulatory role in the nervous system
of the mollusc Lymnaea stagnalis, and another, silent, neuron (B1), see46 for a detailed
description of the general preparation. The CGC was impaled with a single electrode to
record the “pre-synaptic” potential, while two electrodes were inserted into the “postsynaptic” neuron B1, one to record voltage changes and another one for current injection.
The saline and electrode solution used in this experiment are described in the Supplementary
Methods. StdpC was configured as described in Step 10A with an excitatory reversal
potential (VSyn= 0 mV) and standard threshold (VThresh= −20 mV) and slope of synaptic
activation (VSlope= 25 mV). Fig. 3A illustrates the resulting EPSPs (middle sub-panel) and
EPSCs (bottom sub-panel) for tauSyn= 10 ms (blue and red) and tauSyn= 40 ms (cyan and
magenta). For small maximal conductance (30 nS), the current injection could be replaced
by a simple waveform-injection of an alpha-function. However, once voltage-dependent ion
channels are activated in the post-synaptic neuron, the shape of the injected current changes
markedly, almost inverting during a post-synaptic spike (arrowhead, for a more detailed
view see Supplementary Figure 1).
Injecting a simulated Hodgkin-Huxley conductance
As well as simulating artificial synapses between cells, dynamic clamp can also be used to
modify neuron dynamics by injecting simulated voltage-dependent ionic currents. The
results shown in Fig. 3B were obtained by injecting a simulated potassium current (from47)
and described in the supplementary equations) into a cultured hippocampal neuron48, 49
using whole-cell patch clamp50 (the bath and electrode solution used in this experiment are
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described in the Supplementary Methods). StdpC was configured according to Step 10B.
Then, depolarising current steps were introduced into the hippocampal cell to trigger action
potentials. The spike shapes shown in Fig. 3B (top) were observed for an increasing series of
values for the maximum conductance of the simulated current. The amplitude and duration
of action potentials (Fig. 3B, top) decreased monotonically with increasing maximal
conductance for the artificial potassium current. The injected currents are shown in Fig. 3B,
bottom.
Pattern clamp
The CGC was impaled with two electrodes and a pattern clamp protocol was implemented
according to Step 10C. The results are illustrated in Fig. 3 C-E. The pattern specified in
StdpC’s spike generator was an accelerating-decelerating burst which normally would not be
observed in the tonically spiking CGC neuron. Fig. 3C shows two examples of attempted
pattern clamp with gap junction conductance 300 nS (middle sub-panel) and 2 μS (bottom
sub-panel). Due to the large size of the CGC neuron, the 300 nS conductance only achieved
a partial pattern clamp: some of the intended spikes were elicited but others were not.
Furthermore, the pattern clamp was unable to suppress intrinsic spiking of the CGC. In
contrast, at a conductance of 2 μS, the CGC generated every spike of the target pattern
faithfully and did not exhibit any spontaneous spikes. As the enlargements in Fig. 3 D and E
show, the membrane potential of the CGC slightly exceeds the target potential at the top of
the spikes, indicating that actual spikes were induced in the neuron. Furthermore, when
comparing the current injections in D and E (blue traces, bottom sub-panels) we note that
the more than 6 times larger conductance in E leads to only 2-3 times larger current
injections. This is because the CGC membrane potential in E matches better with the target
pattern. It is the ability to deliver sufficiently strong control signals that makes the pattern
clamp successful for the larger conductance, not necessarily the overall amount of injected
current.

Supplementary Material
Europe PMC Funders Author Manuscripts

Refer to Web version on PubMed Central for supplementary material.
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Box 1: Chemical synapse equation and parameters
The synaptic current I is modeled by Ohm’s law with a conductance that depends on the
pre-synaptic membrane potential (h(t) models short term depression, which is not
considered here).

Europe PMC Funders Author Manuscripts
Europe PMC Funders Author Manuscripts
Nat Protoc. Author manuscript; available in PMC 2011 October 06.

Kemenes et al.

Page 19

Europe PMC Funders Author Manuscripts

Figure 1. The general dynamic clamp setup using StdpC

The dynamic clamp system forms a closed observation-stimulus loop in which the measured
and amplified membrane potential (Vout) is input to the StdpC software (StdpC
workstation), which calculates a corresponding trans-membrane current according to a
model specified by the user. The software then issues an appropriate current command,
which is converted into a physical current injection by the amplifier. A second, independent,
analog to digital converter and PC with standard electrophysiology recording software
monitors and saves all aspects of the experiment (Electrophysiology workstation). The
measurement-injection loop is repeated at 10-20 kHz making the interaction essentially
instantaneous for the target neuron.
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Figure 2. The main window of the StdpC graphical interface

The main control elements are marked by 8 markers:

Europe PMC Funders Author Manuscripts

1.

General menus for file control (loading/saving protocols and scripts) and
configuration.

2.

Start and Stop button to control execution of the dynamic clamp

3.

Dropdown choice of the used hardware driver

4.

Message window displaying status information and a log of user actions

5.

Panel for configuring of up to 6 different simulated synapses

6.

Panel for configuring up to 6 ionic conductances

7.

Spike generator module for configuring computer generated neuronal activity.

8.

Data displays for debugging the dynamic clamp configuration.

Many of the configuration buttons open separate dialog windows like the one illustrated in
Box 1.
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Figure 3. Anticipated results
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Example results of dynamic clamp. A) Results of a simulated chemical synapse between a
tonically spiking cell (top) and a silent post-synaptic cell (bottom). The middle sub-panel
shows the injected dynamic clamp current for timescales of 10 ms (blue) and 40 ms (cyan).
The injected current resulted in the EPSPs shown in red and magenta respectively (bottom).
Note how the current through the simulated channels reverts during a post-synaptic spike
(arrow). B) A simulated voltage-activated potassium current was introduced into a cultured
hippocampal neuron. Action potentials were generated by applying 100 pA current steps of
50 ms duration. The effect of the simulated current can be observed as a reduction in
amplitude and duration of the action potentials (top) as the conductance, and therefore the
injected current (bottom), increased. The action potentials were aligned at the maximum
slope of the rising phase as indicated by the dashed line. C) Results of a pattern clamp
experiment. The target cell spikes tonically when the pattern clamp is off (top). When the
gap junction coupling in pattern clamp is not strong enough, the target neuron will only be
clamped partially (middle) but sufficient conductance leads to a complete clamp (bottom).
Pattern clamp is switched on at the arrowheads. Panels D and E are detailed views of the
episodes shaded in grey in panel C. The red trace was recorded from the target neuron, the
black trace shows the desired pattern. Currents injected are shown in blue in the bottom
panels. With 300 nS conductance, the pattern clamp is not able to prevent intrinsic spiking
(C, arrowhead). This is readily achieved at 2 μS maximal conductance even though the
currents injected for this > 6 times larger conductance are only 2-3 times larger owing to the
better match achieved. Animal care and use protocols complied with Home Office (UK)
guidelines. The compositions of the saline and internal solutions used in these experiments
are described in the Supplementary Methods.
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Comments

Commonly used dynamic clamp systems. The real time Linux based systems offer hard real time performance, i.e., guaranteed constant cycle times in the
dynamic clamp cycle. The developers have reported operating frequencies in the 20-50 kHz range. The necessity to install a real time Linux operating
system has been a major impediment for the use of these systems (RTLDC, MRCI, RTLab) by non-experts in the past. However, the recent development
of a live CD based on the Ubuntu Linux distribution for RTXI has made this approach much more accessible. The Comedi libraries support a wide range
of hardware. The systems are very flexible and designed for advanced or expert users with an emphasis on extendibility.
The hardware based systems offer hard real time performance at even more competitive rates (in the >100 kHz range) but are often costly to buy and
update. They are usually less flexible and extendible.
The Windows based solutions Dynclamp 2/4 and StdpC have been developed for novice users and come with predefined models. They allow users to
work within a familiar Windows environment and are ready to use out of the box. However, they are less flexible than RTXI and do not comply with hard
real time constraints. Typical clamping speeds are observed in the 10-30 kHz range and this speed scales automatically with the capability of the dynamic
clamp computer. The scripting function in StdpC has reintroduced some flexibility and the release of the software under the GPL allows full extendibility
for the expert user.
QuB is similar in that it is not a hard real time system but it is more flexible in its model definitions while also being somewhat more demanding on the
expertise of the user. Using high-end hardware the author reports cycle frequencies of up to 150 kHz. The system does not work with Windows Vista and
compatibility with later versions of Windows is unclear.
The new CED dynamic clamp is similar to StdpC in its predefined models and will come as a welcome addition for current owners of CED hardware and
CED “Signal” software. Preliminary reports indicate hard real time update frequencies in the >100 kHz range.
The RTBiomanager, once fully developed, will be a promising system for expert users as it is the first to also combine other stimulation modalities
(mechanical, chemical) into dynamic clamp like protocols.
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Windows based,
NIDAQmx
Real Time
Linux, Comedi

RTBiomanager44

Uses DSP
capabilities of
CED DAQs

Dynamic Clamp
in CED signal

QuB43

Custom analog
hardware and
DSP board.

SM-1, SM-2
amplifiers by
Cambridge
Conductance1,42

Technology
Labview RT,
NIDAQmx,
embedded RT
hardware
subsystem

Name

http://www.ii.uam.es/~gnb

http://www.qub.buffalo.edu/wiki/index.php/Dynamic_Clamp

http://www.ced.co.uk/

-

http://www.hornlab.neurobio.pitt.edu/

URL
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subset of
models in
StdpC; will be
released fall
2010
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